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Legal Aspects 

Use of the software and of the present software manual is submitted to a license 
agreement to be accepted before the software installation on a computer. 

 

 

All suggestion or error concerning the software or this software manual can be sent to: 

 

Astrium 

For the attention of Mr. C. THEROUDE, Mr. G. CHANTEPERDRIX or Mr. M. LEPILLIEZ 

 

Z.I. du Palays 

31 rue des Cosmonautes 

31402 TOULOUSE CEDEX 4 

FRANCE 

This document and the information it contains are property of Astrium. It shall not be used 
for any purpose other than those for which it was supplied. It shall not be reproduced or 
disclosed (in whole or in part) to any third party without Astrium prior written consent. 

 Airbus SAS 2019 - All rights reserved 
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1 About this Document 

This User Manual is intended for users of the PLUME application. 

It consists of the following chapters: 

��  IInnttrroodduuccttiioonn  

Gives a general description of the manual. 

��  GGeenneerraall  PPrriinncciipplleess  

 Gives an overview of the PLUME method and functionalities, the 
 different files and module. 

��  MMaann  MMaacchhiinnee  IInntteerrffaaccee  ((MMMMII))  

 Describes all the elements interfaced with the PLUME application. 

��  CCoommppuuttaattiioonn  mmeetthhooddss  

Presents general computation methods used by the module: 

o Plume impingement 

Presents the module describing the calculation of the plume impingement on 
model meshes: forces and torques, thermal fluxes and mass fluxes. 

��  GGeettttiinngg  SSttaarrtteedd  wwiitthh  PPLLUUMMEE  

 Provides step-by-step instructions for getting started with the PLUME 
 application. 
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2 About PLUME 

PLUME is a plug-in application of the SYSTEMA environment. This manual makes therefore reference to 
the modeller, kinematics, mission and processing modules of SYSTEMA. 

This document presents the PLUME software that computes the plume impingement on the spacecraft 
accounting for the flow fields emitted by one or several thrusters. 

This manual contains task-oriented instructions which show you how to use the PLUME program. The 
different computation techniques supported by PLUME are also presented. 

 

� Document issue: 1.0 

� Software release: PLUME Version 4.5.2 
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3 Glossary 

In this User Manual, some terms have a specific meaning: 

Term Meaning 

Local / inherited 
 The “local” and “inherited” notions are explained in the 

SYSTEMA User Guide (Chapter  “Geometrical model management”) 

Activity In terms of plume impingement application, the question is to 
determine whether a surface receives or not particle emitted by 
thrusters. An inactive surface is considered as not present in the flow 
field. 

Specific Items The specific items (or virtual nodes) are elements defined in the 
meshing model, on which results are computed (Groups) or allowing to 
extend standard geometrical definition (Thrusters). 

Referenced shapes When creating a virtual node, the shapes selected for its definition are 
called referenced shapes. For a group, this is the list of surfaces on 
which the user wants to have mean or maximum values. For thrusters, 
it is the cone by which the flow field is emitted. 

Thrusters A thruster is the surface which will emit the flow field. 

Group A group is a set of surface on which the post-processing of results will 
be modified. 
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4 Typographic Conventions 

The following typographic conventions are used in this manual: 

Convention Description Example 

light blue Used for the PLUME-related functions The PLUME application is interfaced 
with… 

Blue Used for the SYSTEMA-related functions Within the SYSTEMA processing 
tab… 

 
These colours are used in the diagram of Chapter Man-Machine Interface to 
distinguish the SYSTEMA entities from the PLUME ones. 

Italics Names of the options related to the 
current entities or filenames 

Fit – Material Filename
*
– Physical 

properties 

Numbered list Procedure containing the several actions 
to be performed 

1. Click the Revert button. 

2. Enter a new value. 

Bulleted list Items list This container will affect the following: 

� Forces and torques units 

� Thermal fluxes unit 

� Mass fluxes unit 

 

 

 

A warning calls attention to information that is essential to run successfully the 
PLUME application. 

 

 

A caution calls attention to important information which, if not understood, will 
lead to a conflict or an error. 

 

A note provides additional information to emphasize or explain important points in the 
manual. 

 
Cross-reference: prompts the user to refer to a particular section in the manual or to a 
special document. 

 

                                                 

 
*
 Material Filename is the name of the material which has been loaded during the SYSTEMA session. 
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Man-Machine Interface 

(MMI) 
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1 Overview 

1.1 Introduction 

This chapter describes the general ergonomic principles and basic procedures for using 
the PLUME application into the SYSTEMA platform. 

The application may be illustrated as follows: 

.h5 

Processing 

Module 

.sysset 

Post-processing 

geometrical 

model 

meshing & 

numbering 

interface 

.sysmis 

mission 

.sysmsh 

.sysmdl .syskin 
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- Plume Impingement 

PLUME 

Hdf5 results 

Tab 

Tab 

SYSTEMA 

Tab 

Applications

Properties 

Meshing & 

Numbering 

library 

Symbols Used for 
 

Output files 

 Tabs 

 Post-processing 

 
Optional input 

 

Kinematics 
Tab 

 

Figure 1 -  PLUME within SYSTEMA 
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1.2 In this Chapter 

This chapter covers the following topics: 

� How to perform a plume impingement analysis. 

� Using the interactive Modeler module. 

� Meshing and numbering. 

� Using the interactive Mission module. 

� Using the interactive Kinematics module. 

� Using the interactive Processing module. 

� Post-processing. 
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2 How to Perform a Plume Impingement Analysis 

The PLUME application is interfaced with SYSTEMA. Consequently, to use the PLUME package, the 
analysis must start with the generation of the geometrical model of the space system. 

This first step of the analysis can be performed: 

� Using the interactive 3D MODELER. 

A kinematic can also be designed. This second step can be performed: 

� Using the interactive KINEMATICS module. 

In this case, a mission has also to be designed. This step can be performed: 

� Using the interactive MISSION module. 

The different steps to build a plume impingement analysis are performed:  

� Using the interactive PROCESSING module. 

 

As shown in the illustration (Figure 1 - PLUME within SYSTEMA), some SYSTEMA 
modules (Modeler & Processing) are completed by PLUME specific tabs. 

Within the SYSTEMA processing tab, the PLUME application is organized into one module, which is 
based on 1 sub-application and used to manage the PLUME entities: 

Plume Impingement: this module is used to calculate the dynamic effects (forces and 
torques), thermal effects (heat flux) and contamination (incident 
and deposited mass). 

 
The above-listed modules are shown on (Figure 10 -  PLUME modules). 
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3 Using the Interactive MODELER Module 

The Modeler tab is used to work on models and meshing. According to the SYSTEMA configuration, 
some applications can be interfaced with SYSTEMA. In this case, the elements of the geometrical model 
have application-dependent properties. 

These properties can be consulted or modified using the edition window, via a specific tab (called 
“PLUME tab” in this document). Each application has its own tab. 

For a given application, material files may be required to define the application-dependent properties. 
These files are declared at the root level of the geometrical model. 

 

Refer to SYSTEMA User Guide (Chapter 4: “Geometrical Model Management”). 
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3.1 PLUME Material Tab 

The user defines material associations via the specific tab of the edition window. PLUME 
is provided with a default reference material. However, the user may want to use its own 
material database. In the following figure, the user can associate a material file with the 
application-dependent properties. 

EExxaammppllee  

The Material tab (Figure 2 - PLUME material tab) lets the user enter a material filename 
for the physical properties. 

To get access to this window, open the edit window at the root level and unselect “Use 
default material database”. 

 

Figure 2 -  PLUME material tab 

 
The “.sysmtr” file contains properties of the materials used in the model. A material editor 
accessible from material sub-tab in the SYSTEMA modeller tab allows to create or 
modify the material file. The materials are visible as a green bulleted list. 

 
PLUME is delivered with a reference material database. By default, all newly created 
models will be linked to this reference material database. Use the above procedure to 
attach or create a user defined material database. 

 
 

Specific tab 

Click  to select a file 
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3.2 Applicative Properties 

 

There are 3 property clauses called "containers". These containers (PHYSICAL, 
TRANSPARENCY and COMPUTATION) include applicative properties sub-groups. 

Some of these sub-groups may globally be assigned by a material. 

Physical 

This container refers to the material settings. 

Related properties 

The properties linked to this container are as follows: 

o Dynamic effect (Absorptivity, Dynamic Specularity, Dynamic 
Accomodation). 

o State (Temperature). 

o Thermal effect (Thermal Specularity, Thermal Accomodation). 
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EExxaammppllee  

 

Figure 3 -  Object edition 

Activity 

Here, the question is: 

o Is the surface taken into account in the plume impingement calculation? 

If the user wants the surface to be taken into account in the calculation, the Activity 
has to be set to “yes”. Otherwise, the Activity has to be set to “no”. The activity is thus 
the answer to the question. 

Transparency 

This container refers to the transparency material settings. 

Related properties 

The properties linked to this container are as follows: 

o Transparency (Phase shift and seven pairs of coefficient/exponent) 

Activity 

No activity. 
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Computation 

This container refers to ray tracing algorithm. The Emission property switch allows to 
enable computation on a surface. When choosing “shadowing” the plume impingement 
on the surface will not be computed, but the ray-tracing algorithm will consider the 
surface when computing plume impingement for other surfaces (shadowing effect). 

Related properties 

The properties linked to this container are as follows: 

o Ray emission (Emission, ray building method, ray number per mesh or 
ray density and maximum/minimum number of rays per mesh) 

Activity 

No activity. 

Configuration 

 

Refer to SYSTEMA User Guide (Chapter 4: “Geometrical Model Management”). 

The tabs in PLUME have inheritance properties which are identical to those of 
SYSTEMA. It is thus possible to redefine a configuration locally (inheritance removed). 

EExxaammppllee  

You can enter the value at the higher level and make the next level inherit this value 
(default behaviour). 

 

The parameter values can be modified even when in an inheritance configuration.  

In order of priority, a parameter may be affected by: 

� Value overloading (local value). 

� Material overloading. 

� Inherited value (value inherited from the father). 

� Default value. 

 
The customization option ‘Overload’ lets the user overload the material’s default value. 

 

Refer to SYSTEMA User Guide (Chapter 4: “Geometrical Model Management”). 
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3.3 Importing a SYSEXP File 

This function allows files (file.SYSEXP) from a previous PLUME application (version 3) to 
be imported and to be compatible with a new PLUME application. 

To open the existing model: 

1. Open the Modeler tab in SYSTEMA. 

2. To open the existing model, click the File -> Open menu. 

The Select the file to open dialog box opens: 

EExxaammppllee  

 

3. In “Files of type”, select Import: SYSEXP file (*.SYSEXP). 

4. Open the “*.SYSEXP” file.  

The model is displayed in the 3D view in the PLUME application. 

You can work with the file.  

5. Click the File -> Save menu to save the file as .sysmdl (V4 format). 
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4 Interacting with the Meshing 

The entire geometrical model has to be meshed to perform a plume impingement analysis. 

The meshing may also contains additional information. These additional information are stored in specific 
items, either Group specific items or Thrusters specific items. In this case, the user has to provide 
PLUME properties to the created specific items. The Trusters specific items allow to define the emission 
point of the ray tracing, whereas the Group specific items may allow to modify the content of the output 
files to help the user in obtaining macroscopic results. 

4.1 Plume Impingement 

Meshing 

The meshing is associated with an inheritance property and can be accessed from the 
tree structure. 

� Application name: 
Determines the application for which the meshing is performed (useful in 
case PLUME is not the sole installed application). 

 

Refer to SYSTEMA User Guide (Chapter 4: “Geometrical Model Management”). 

 

The meshing of shapes consists in splitting the surfaces according to a certain number of 
meshes in each principal direction: this is the “a, b & c” meshing library. 

For the PLUME application, there is two ways of setting the “a, b & c” parameters: either 
directly, or by choosing a Length. In this case, the “a, b & c” parameters will be adjusted 
so that the characteristic size of the meshes correspond to the chosen length. For 
revolution shapes, a second parameter is available: the maximum angle which allows to 
define a minimum angular sector to mesh with (“a” parameter). 
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The three parameters: “a”, “b”, “c” define the number of desired intervals in a specific 
direction. 

� Parameters “a” & “b”: refer to all two-dimensional elemental surfaces. 

� Parameter “c”: refers to three-dimensional surfaces. 

The following shapes may be distinguished: 

� Triangle, rectangle, quadrangle 

Triangle Rectangle Quadrangle 

 

 

 

 

� Disk, cylinder, cone, parabola, antenna, sphere 

Parameter Segmentation based on: 

a angular sector 

 

Parameter Shape Segmentation based on: 

b  disk radius 

cone, cylinder height 

sphere, parabola curvilinear abscissa in iso 

antenna radius 

 

P1 

P2 P3 
b = 2 

a = 3 

a = 3 

b = 2 

P1 P2 

P3 

b = 2 

a = 3 P1 P2 

P3 P4 
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� Polygons 

o The meshing corresponds to the number of desired intervals in a 
specific direction. This does not apply to the polygon which is a 
particular case because it is divided in triangles and, consequently, only 
the “a” parameter will have an impact as regards the detail of surface 
triangulation. 

� Shape macros and shapes with third dimension 

o Parameters “a” & “b” refer to the basic meshing (see above described 
categories) 

o The “c” parameter completes the meshing in the third dimension. 

Numbering 

It consists in numbering the surfaces for assigning a number to meshes and defining an 
increment value. Actually, it is an incrementation used for the global numbering of the 
model or a sub-part of the model to obtain a mesh network with a meaningful numbering 
system. 

 
SYSTEMA provides an automatic numbering sufficient for a PLUME calculation. 

 
Inheritance notion: for a numbering, an incrementation is defined. 

EExxaammppllee  

 

 

Figure 4 -  Inheritance principle for numbering exemple 

At this level, the following 
parameters have been defined: 

• Submodel Name =Sub1 

• Start Number = 10000 

• Shape Increment = 1000 
• Mesh Increment = 1 

Mesh numbers 
incremented by 1 

Shape number 
incremented by 

1000 
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4.2 Thrusters specific item 

Meshing 

The Thrusters specific item is the way to define thrusters for the plume impingement 
analysis. 

It is defined in the meshing model by one referenced shapes which must be a cone. The 
emission point will be the center of the cone’s base having the larger radius. The 
orientation of the thruster is deduced from the orientation of the geometrical cone shape. 

To create a thruster from selection: 

1. Open the required meshing model. 

2. Select one cone representing a thruster. 

3. Via the right click menu, select Create specific meshing item -> Thruster. 

4. A window opens (see Figure below). In the General Tab, in clicking on Display 
Browser, the user can check which shape is referenced. 

                                              

Figure 5 -  Thruster referenced shape setting 

5. Set the thruster properties in the Plumimp tab: Thruster files and Firing (Activity, 
droplet density, firing duration), see below. 

Numbering 

At the thruster creation, a default numbering is performed by SYSTEMA. 
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Plume Properties 

The properties of the Thruster specific item are the following: 

 

 

 

Figure 6 -  Thruster PLUME properties setting 
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4.3 Group specific item 

Meshing 

The group specific item is a way to define a set of shapes on which plume impingement 
results will be cumulated (mean or max values of some quantities). 

It is defined in the meshing model by a set of referenced shapes which must be the set 
of shapes to be accounted for mean or max computation. 

To create a group from selection: 

1. Open the required meshing model. 

2. Select one or several shapes of the geometrical model representing the set of 
shapes of the group to account for. 

3. Via the right click menu, select Create specific meshing item -> group. 

4. A window opens (see Figure below). In the General Tab, it can be checked that the 
correct shapes are referenced. 

 

Figure 7 -  Group referenced shapes setting 

5. Set the volume property in the PLUME tab, see below. 

Numbering 

At the group creation, a default numbering is performed by SYSTEMA. 
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Plume Properties 

The PLUME properties of a Group specific item are a set of choice depending on what 
has to be computed on the set of surfaces. 

. 

 

Figure 8 -  Group properties settings 
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5 Using the Interactive Kinematics Module 

This Kinematics module allows to define new reference frames with respect to the main reference frame 
define in the geometrical model. For the PLUME application, this allows to simulate rotating solar panel. 

 

How to create a kinematic: 

1. Go to the Kinematics tab 

2. Select File -> New in the top menu 

3. Following the general rules defined in the SYSTEMA user manual, create à new 
pivot in setting successively:  

4. A rotation axis (X, Y or Z) 

5. Possibly a transformation to handle the shift between the new reference frame 
position and the main reference frame. For instance, in the case of a rotating solar panel, 
a one point translation is sufficient. 

6. Choose a Linear attitude and set the corresponding parameters: repeat the rotation 
axis; choose either “Absolute time Gamma50 (day)” or “Phase elapsed time (sec)”; a 
rotating speed (A1) and possibly an initial angle (A0). 

EExxaammppllee    
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6 Using the Interactive MISSION Module 

This Mission module is a basic association module (Geometrical model, Meshing model, possibly 
Kinematics model) making up the application inputs. It is not mandatory to build a mission to perform a 
plume impingement analysis if there is no kinematics to account for. 

 

How to create a mission: 

1. Go to the Mission tab 

2. File -> New, the following  window opens 
 

                                 
 

3. Either click OK if the suggested model, meshing and kinematics are the one defining 
the desired computation or select the relevant model, meshing and kinematics if 
necessary. Then click OK 

4. Possibly link a kinematic to an object and define the computation points in following 
the general rules defined in the SYSTEMA user manual (see also below example 
figures). 

5. The mission is set and will be available in the processing tab to be attached to a 
process. 
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EExxaammppllee    
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7 Using the Interactive PROCESSING Module 

This module is composed of a sequence of processes, which are specific to the associated application. 

A calculation is defined (mission or meshing selected) and performed (run). 

The analysis that will be performed using the mission or meshing will output the results based on 
Plumimp module. 

 

Refer to SYSTEMA 4.5 User Guide (Chapter 8: “Process Management”). 

 
The modules are not detailed at this stage. In this User Manual, you will find chapters 
dedicated to the different modules. 

EExxaammppllee  

1. Open the Processing tab in SYSTEMA. 

2. To open a new processing, click File -> New menu. 

Here are the menus proposed in the SYSTEMA Processing tab: 

 

Figure 9 -  SYSTEMA Processing tab display 
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7.1 Basic Rule 

To display the PLUME available processes on the process browser:  

♦ Click PLUME. 

 

 

 

 

 

 

 

 

 

                                      

 

Figure 10 -  PLUME modules 

To display a PLUME module: 

♦ Double click (or Drag and Drop) the selected PLUME module (Figure 11 - 
Plumimp module). 

EExxaammppllee    

 

Figure 11 -  Plumimp module 

 

Double click  

Plumimp module to 
display this process 



Man-Machine Interface (MMI)  PLUME User Manual 

26/30  Astrium SAS 2013 – All rights reserved REF: ASTRI.UM.763751.ASTR 

 

 

To display the edit or delete option for one PLUME module, as shown on the following 
window, the user can perform the following actions on the selected PLUME module: 

♦ Double click. 

♦ Right click. 

 

Figure 12 -  How to get access to the Edit or Delete option of a PLUME module 

EExxaammppllee  

 

Figure 13 -  Edit or delete option of the PLUME Plumimp module 

� Using the delete option on any PLUME module enables the user to make 
this module disappear. 

� As regards the edit option, the PLUME module selected has its own run 
parameters. 
The run parameters have two tabs: 

o Computation: it allows to select option concerning shadowing and 
transparency. It is where also the reference point for torques calculation 
has to be set. 

A double click 
or a right click 
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o Spread sheet report settings: this allows to tune the results written in 
the “xls” output files. Note that this settings do not act on the content of 
the h5 results file 

EExxaammppllee  

Run parameters available for the Plumimp Module 
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8 Post-Processing 

 

Refer to SYSTEMA 4.4 User Guide (Chapter 8: “Process Management”, § “Using 
process result”). 

The .h5 files can be used to display the results in the Modeler tab. 

1. Open the Processing tab in SYSTEMA. 

2. Click Load to load the result file (.sysres). 

EExxaammppllee  

 

8.1 How to Display Results in a 3D View 

EExxaammppllee  

1. Open the Modeler tab in SYSTEMA. 

2. Open the meshing model. 

3. In the 3D view, via the right click menu, select Configuration window. 

4. Select the result file and the property (for example: Thermal Fluxes) you wish to display. 

5. Close the configuration window. 
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In the 3D view, the meshing model is displayed showing the results. 

8.2 How to Display Results in a 2D Curve View 

EExxaammppllee  

1. Open the Modeler tab in SYSTEMA. 

2. Open the meshing model. 

3. In the view menu, choose add -> Curve view. 

4. Via the right click menu, select Configuration window then load the meshing. 

5. Select the result file and the property (for example: Thermal Fluxes) you wish to display. 

6. Select a node on wish you want to see the quantity evolution according to time 

7. Close the configuration window. 
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In the curve view, the curve is displayed showing the results. 
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General Principles 
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1 Overview 

1.1 Introduction 

In this chapter the user will find some general principles that he has to know before using 
the PLUME files and modules. 

The PLUME software predicts the plume effects in terms of dynamic effects, thermal flux 
and contamination on any spacecraft. 

The increasingly complex design of satellites imposes constraints on thruster’s 
implementation used for orbit and attitude control of spacecraft. The impingement of 
exhaust products of thrusters may present various detrimental effects: 

o Forces and torques caused by the impingement of the gas plume producing 
dynamic perturbations and a loss of thrusters efficiency. 

o Undesirable thermal constraints due to the convective heat flux. 

o Contamination due to the deposition of vapours or droplets on the surface of 
sensitive components such as optics and sensors, affecting their 
performance. 

o Erosion caused by the particles and the impingement of unburnt droplets. 

The prevention of those effects on sensitive surfaces that might compromise mission 
objectives and lifetime, interest more and more the satellite design engineers. 

To optimise the positioning of thrusters with respect to the performance efficiency and the 
plume effects, it is essential to have a comprehensive understanding and quantitative 
characterisation of the pressure, thermal and contamination effects of the exhaust plume 
of the thrusters at their typical operating conditions. 

The software is intended to provide a tool for evaluating plume impingement received at 
points within spacecraft geometry.  

The main functions of PLUME are as follows: 

� Geometry modelling and physical properties & meshing. 

� Physical simulation: plume effects analysis: 

- Plume impingement: calculation of the dynamic effects, heat flux and 
incident mass due to the impingement of the gas ejected by one or 
several spacecraft thrusters. 
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2 PLUME-Specific SYSTEMA Tabs 

Here the PLUME package is fed back to the SYSTEMA environment. 

The MODELER and PROCESSING tabs have the same layout. 

 

 

A detailed table will be proposed in the relevant MMI related sections to describe each 
tab. 

EExxaammppllee  

Here are the options proposed in the Edit menu of the SYSTEMA Modeler tab: 

 

Figure 1 -  Options proposed in the SYSTEMA Modeler tab 

For each tab, the menu consists of both general and specific options. 
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The standard options are as follows: 

Edit menu (contains options applicable to entity components) 

Option Used to: 

 Enter a specific entity created for PLUME 

 Select the file to open 

 Remove an entity (property, file, etc...) 

 Cancel the display and return to the  option 

 

 

Issue a warning or provide information on the processed nodes or the 
current configuration. 

The local errors (e.g. a forbidden value) are identified in red. However, 
some elements cannot be automatically returned in error. 

If it is not an error to be locally corrected, a warning displays in the 
lower window. The error is detailed and can be corrected in another 
area. 

 Validate the selected component(s) 

 

 

The  button is disabled if any error is still present in the information area. 
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3 PLUME Module and Corresponding Files 

In this User Manual, the "module" or "PLUME module" terms will be used to refer to the sub-processes 
managed by the PLUME application, namely plume impingement. 

The module defines its input files, parameters and output files. 

The parameters for the module will be detailed in the chapters dealing with it. 

The following tables present the module and corresponding files: 

INPUT File extension 

Module File extension 

Plume Impingement  ".sysset" 

“.flow”, “.thermo” 

 
 

OUTPUT File extension 

Module File extension 

Plume Impingement “.plu.h5”, “.info.h5” 

“.plu.log” 

“.pluft.xls”, “.plutf.xls”, “plumf.xls” 

 

 
INPUT file extension 

The “.sysset” file refers to a mission defined in the SYSTEMA V4 platform. 

The “.flow” and “.thermo” files contain the flow field emitted by the thrusters and the 
corresponding thermodynamic tables. These are files produced by the Plumflow 
application. 

OUTPUT file extension 

The “.h5” outputs are HDF5 files used for result interpretation. They can also be 
loaded into an HDF explorer. 

The “.log” file provides general information. 

The “.xls” files output by the module are results written under HTML format, readable 
under an internet browser or a spread sheet report editor. 
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Computation methods 
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1 General Method: Plume Impingement Computation 

1.1 Overview 

The PLUME software evaluates the impact of one or several firing thrusters on the spacecraft 
geometry. 

The analysis is based on an analytical ray-tracing technique. Rays are traced from the thruster of 
interest to all the meshes of the geometry. Each ray provides information regarding the current 
mesh and the thruster: incidence angle, distance to the thruster, etc... If another surface is 
encountered, the current mesh is said to be shadowed. Otherwise, the impact parameters as well 
as the derivate quantities are computed, cumulated (on meshes, on surfaces and possibly on 
groups) and stored in the corresponding file: in the Impingement information file for the impact 
parameters and in the Derivate quantities file for the other quantities. 

The impact parameters on the non-shadowed meshes are calculated as following: 

� For each of the launched rays, the distance and elevation angle with 
respect to the thruster axis are computed. 

Thanks to these information, the local undisturbed thruster flow and 
thermodynamic is interpolated in the FLOW and THERMO input files 
computed by the Plumflow module. The interpolation is made by using the 
meshed flow field contained in the FLOW input file. 

This procedure is approximate, in that it ignores the effects that the 
presence of the surface could have had on the thruster flow field. 

� For each of the launched rays, from the properties of the surface and the 
impact parameters, the impact pressure, shear stress, thermal flux and 
mass flux are computed. 

Then the force, torques, thermal and mass fluxes are computed according 
to the chosen Impact model (only Knudsen model implemented, 
corresponding to the free molecular regime assumption). This computation 
is an integration over an elementary area: for instance the force vector is 
the integration of the vector formed by the impact pressure (normal 
contribution) and the shear stress (tangential contribution). 

� The quantities are cumulated on the mesh, on the surface to which the 
mesh belongs, possibly on the group to which the surface belongs. The 
quantities are also cumulated on the overall model. 

This accumulation is also an integration process: for instance the force 
contribution on a surface is the integral of the impact pressure and shear 
stress over this surface, which is decomposed on the mesh contribution 
(simple sum). 
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1.2 Thruster definition 

The PLUME software has to be aware of which cone shapes are supposed to represent the 
thrusters. This association is done in using the Thruster specific item. 

Apart from this emitting shape, a thruster is also defined by a pair of input files: the FLOW file and 
the THERMO file. The first one provides the flow field on some mesh. This flow field is defined by a 
set of quantities: density, velocity and pressure of the gas flow. The mandatory quantity to be 
present in the FLOW file are: 

• The density (label “Density”) 

• The temperature (label “Temperature”) 

• The velocity norm (label “Velocity Module” or “Velocity module”) 

• The velocity local angle (label “Velocity Angle” or “Velocity vector”) 

All the other quantities present in the FLOW file are loaded but not used during computation. 

The second file provides the thermodynamic relationship between the temperature and the 
pressure as well as other gas properties (molar mass, etc…). These two files are defined either at 
thruster definition level if each thruster has a different flow field or at processing level if a set of 
thruster file can be shared between thrusters. 

These first two information (cone position and flow field) allows to compute the impact parameters, 
as well as the forces / torques and the thermal flux on every meshes. This also sufficient to 
compute the incident mass flow rate expressed in kg/m²/s. 

To compute a mass flux expressed in kg/m² (or in µg/cm²), the firing duration is necessary, 
assuming that the flow field is stationary. Then, to compute a mass deposit expressed in m (or in 
µm), a density is necessary. These two additional parameters have to be set during the thruster 
definition if the user want to compute mass flux or mass deposit on the surfaces of the spacecraft. 
The incident mass flow rate (or flux, or deposit) is obtained by multiplying the local incident mass 
flow rate by the local absorption coefficient. 

 

1.3 Group definition 

During the computation, the different quantities are cumulated on meshes. Then the mesh results 
are cumulated on surfaces and finally the surface results are cumulated on the overall spacecraft 
geometry. The integrated information at spacecraft level is generally sufficient, particularly for 
forces and torques evaluation. 

On the other hand, if the user wants to have integrated quantities on a reduce part of the 
spacecraft, the surface level may be too fine. Conversely, the overall spacecraft level may be too 
coarse: an intermediate level of detail could be interesting. That is why the concept of groups has 
been naturally introduced. 
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A group is thus a set of surfaces on which integrated quantities are cumulated (by cumulating the 
integrated quantities on the corresponding surfaces). The user can define which quantities he 
wants to store: force and torques, thermal flux and/or mass flux and for each of them, he can 
decide whether to store or not the mean and the maximum of this value. 

The corresponding group quantities are stored in the h5 plume impingement file and are available 
during post-processing for curve display (or textual information). They are also stored in spread 
sheet report file for direct text access. 

One folder is created for each of the thruster present in the computation and the corresponding 
spread sheet report files are stored inside this specific folder. The unit of the quantities contained in 
these files are set by the module processing parameters. 
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2 Plume Impingement 

2.1 Theory 

Introduction 

Owing to the great complexity of the 3D flow due to the impingement of a plume on 
spacecraft geometry, only local methods are applicable in the context of engineering 
computations. The main features of those methods are: 

• Only suited to hypersonic or free molecular flows, 

• Only local flow: the impingement at a point ignores the surrounding impingement, 

• Only the surfaces in the direct field of view receive the impingement. 

The local method depends on the impingement regime, although for the moment, only the 
free molecular regime is implemented (Knudsen model). 

Principles 

The general principle of MATPLIMP computational scheme is presented hereafter. 

Modelling 

First, the body is described as a collection of analytical shapes. Each surface is then 
discretized into simple elements, small enough for the local flow to be considered as 
uniform. The area and the oriented normal of each element are computed by means of 
the diagonal cross products. 

Local flow computation 

To locate the nozzle exhausting the gas, two points are required: 

• The exit section centre, 

• A point on the axis. 

Because the flow-field file is defined in a reference associated with the nozzle, the 
coordinates of each element centre are first transformed into the nozzle coordinate 
system. 

The flow-field file generated by PLUMFLOW is ordered in a regular meshing formed by 
quadrangular cells. For each cell vertex, the following data are supplied: 

• Xp/R*, Rp/R*: coordinates normalized by the throat radius, 

• T: static temperature (K), 

• ρ: gas density (kg/m2), 

• V: velocity modules (m/s), 

• α: angle between the velocity vector and the plume axis 
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The computation of the impact parameters is performed as followed 

(a) The first step is to know which plume cell contains the element centre. In that view, 
access tables are created, allowing to limit this searching to some cells only. 

(b) The following step is to compute the flow parameters at the point M by a classical 
bilinear interpolation. 

(c) The last step is to compute the unit vector giving the direction of the gas velocity and 
the tangential unit vector, then the angle θ between the velocity and the vector normal to 
the element. 

Shading effects 

In the case of complex geometries, some surfaces can occult a part of the analyzed 
geometry. To take into account these shading effects, the program operates as follows: 

• Shadow effects are computed by testing the intersection of the streamline passing 
through the element centre and all the analytical surfaces making the geometrical model. 

• The curvature of the streamlines is neglected (only valid if the model is not too close 
to the nozzle). That is to say the streamlines are assumed to be straight lines and a ray 
tracing algorithm is used to determine if there is shadowing or not. 

Note: the pressure is supposed to be equal to zero (space vacuum) on the part of the 
geometry occulted from the plume. 

Impingement computation 

The equation used to compute the impingement effects are: 

• Forces and torques: 

Forces and torques are derived from the impingement pressure and the tangential stress: 

( ) ( )Transp1aXnPF timp −+= ....∑ τrr

 

( ) ( )Transp1aXOMnOMPC timp −×+×=∑ .... τ
r

 

Where: 

F  , C  are the resulting forces and torques, 

M is the element centre, 

 n  is the element unit normal, 

tX  is the tangential unit vector, 

a is the element area, 

Pimp, τ are the pressure and tangential stress, 

O is the reference point for torques computation, 

Transp is the transparency (see hereafter). 
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• Thermal flux: 

∑= locw QQ  

∑
=

i

w
moy

X.a

Q
Q  

Where: 

Qw is the received thermal power, 

Qloc is the local thermal flux, 

Qmoy is the mean thermal flux, 

Xi is an indicator of the element visibility. 

The computation of Pimp, τ and Qloc is described hereafter. 

Impingement regime 

The impingement regime is characterised by the Knudsen number, given by: 

ref

n
L

K
λ=  

Where: 

Lref is the characteristic length, 

 λ is the mean free path, defined by: 

RT2ρ
πµλ =  

Where:  

µ is the dynamic viscosity, 

ρ is the density, 

R is the gas constant, 

T is the gas temperature. 

Lref is often difficult to define. Generally, it represents the length of the impingement body 
edges for little bodies or the minimal distance between the body and the nozzle, for 
objects of great size. The mean free path is stored in the Impingement Information file. It 
can help the user to know whether the free molecular regime is a good approximation. 

The computation method is deduced from the flow regime as follows: 

If Kn < 0.1, the regime is continuum: Newton approximation, not implemented 

If 10 > Kn > 0.1, the regime is transitional: empirical bridging, not implemented 

If Kn > 10, the regime is free molecular: gas kinetic theory, see hereafter. 
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Free molecular regime: Knudsen model 

This model is a three parameters model; it is an improvement of the well-known Maxwell 
model. 

The basis of the model is that the molecules impinging a surface can produce three types 
of interactions: 

• The specular reflection, the τ parameter (specular reflection ratio) is the ratio 
between the specularly reflected mass flux and the reflected mass flux, 

• The energy accommodation, the α parameter (wall accommodation ratio) is the 
ratio between the energy given to the surface by the diffuse reflected molecules 
and the energy given to the surface if the molecules were diffusely reflected with 
the surface temperature. It applies only for the diffuse part of the reflected 
molecules and can be written as: 

wi

di

QQ

QQ

−
−=α

  

Where Qi is the energy of an incident molecule, Qd is the energy of a diffuse reflected 
molecule and Qw the energy of a molecule reflected diffusely at the wall (surface) 
temperature. 

For a mass flux &m impinging a surface, the Knudsen model assumes that: 

- The fraction τ &m is specularly reflected, 

- The fraction (1-τ) &m is diffusely reflected with an energetic accommodation defined 

by the α parameter. 

 

The effects that are computed are: 

• The impingement pressure: 
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• The heat flux: 
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• The tangential stress: 

( ) θτσ cos... SA1P P−= ∞  
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Where: 

∞

∞=
RT2

V
S

 is the molecular Mach number 

( ) ( )( )werf1ww
1

A 2 ++−= exp
π  

( )θsin.Sw =
 

 

Transparency 

A transparency Transp can be used for certain materials. It is computed with the following 
expression: 

( )∑ -cos
exp

NBTERM

1i

0i
izTransp

=

= θθ
 

Where: 

NBTERM: Number of terms of the polynomial 

zi: Coefficient of the i
th
 term 

expi: Exponent of the i
th
 term 

θ: Incident angle wrt the normal to the surface  

θ0: Phase angle 
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2.2 Parameters 

This section gives an overview of the windows in this module. 

 
The parameters set in the different fields correspond to the default values. 

 

Spread sheet report settings Computation settings 
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2.3 Input / Output 

 

In this PLUME User Manual, refer to the General Principles in Chapter 2 (PLUME 
Modules) for the “INPUT” and “OUTPUT” tables of the different modules and 
corresponding files. 

Input 

� .SYSSET file 

o Mission synthesis file for the PLUME application. This file is mandatory 
and is created by the SYSTEMA “Current Mission” process module. 

� .FLOW and .THERMO file  

o Description file of the thruster emitted flow field. These files are not 
mandatory in the case that a FLOW and THERMO file has been attached 
to each of the defined thruster (in the meshing part). 

Output 

� .PLU.LOG file 

o General information file gathering messages written during the 
computation. If the computation does not go to an end, an error 
message or a warning may be found in this file. This file cannot be 
deactivated. 

� .PLU.H5 file, .INFO.H5 file 

o Used to display the impact parameters (interpolated in the flow file) and 
the derivate quantities. These files cannot be deactivated. 

� .ft.xls (forces-torques), .tf.xls (thermal flux) files 

o Files containing integrated quantities under HTML format. These files 
can be opened with standard spread sheet report editor. These files 
cannot be deactivated. 

 

� .mf.xls (mass flux) file 

o File containing integrated quantities under HTML format. This file can be 
opened with standard spread sheet report editor. This file can be 
deactivated. 
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3 Content of the result files 

3.1 Impingement information file 

This file contains data coming from the ray tracing results and from the interpolation in the flow field 
file. The data in this file can be used for finely understand the results. It can be used in 3D Views 
(either in the meshing or in the mission tab) for result display as coloured or textual information on 
meshes. It can also be used in Curve Views to display time dependant results on meshes. 

General information data 

This part contains the number of rays that have been fired as well as the area of the 
meshes. 

Ray tracing data 

This part is sorted by Thruster. For each truster, the following information are available: 

• Area ratio in the plume: if only one ray has been fired has been launched, the 
value is simply 0 or 1, depending if the center of the mesh is shadowed or not; if 
several rays have been fired, the value will be between 0 and 1. 

• Angle with respect to the Thruster axis: angle between the normal to the mesh 
and the thruster axis 

• Incidence angle with respect to the normal: angle between the local velocity 
vector and the normal to the mesh 

• Distance to thruster. 

“From flow file” data 

This part is also sorted by Thruster. All the quantities available here are interpolated in 
the FLOW file, or computed from the FLOW and THERMO file. For each truster, the 
following information are available: 

• Directly interpolated: Density, Velocity norm, Velocity angle, Temperature, Bird 
Number (if present in the FLOW file, otherwise, zero) 

• Computed: Pressure (with standard perfect gas formula involving the density, the 
temperature and the gas constant), Mean Free Path. 

The following figure gives an example of the content of this file as seen in the graphical user 
interface. 
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Sorted by thruster 

 

 

 

From Flow file data 

 

Ray tracing data 

General information 

 

  



PLUME User Manual Computation methods 

REF: ASTRI.UM.763751.ASTR  Astrium SAS 2013 – All rights reserved 17/20 

 

3.2 Derivate quantities file 

This file contains cumulated data over meshes, surfaces and possibly groups. The surfaces and 
groups results parts are only available for “textual information”, curve view or table view display. 
The positive and negative side of the surfaces / groups are also split. The meshes results part is 
available for every kind of display. The negative and positive side are not split because the 
negative and positive side of a mesh are distinct meshes. 

Results sorting 

 

First sorted by kind of result 

(surfaces, meshes) 

Then sorted by thruster, then by side 

(for surfaces and groups). 

An additional thruster is available, called 

“All Thruster”, allowing to have 

information cumulated as if all thrusters 

were firing at the same time. 

 

 

Available data for post-processing 

 

Maximum quantities 

• On meshes, the Max Thermal Flux and Max Net Mass flux are computed as the 
maximum value obtained among the fired rays on each mesh. For instance, in 
the case where the user has fired only one ray, the Thermal Flux and the Max 
Thermal Flux value are the same. All thruster computation is done by taking into 
account the maximum contribution of all thrusters on each mesh cell (i.e. the sum 
of the most energetic ray from each thruster on a given cell).   

• On surfaces (or groups), the maximum quantities are obtained as the maximum 
value obtained among the maximum values on the meshes composing the 
surface (or group). For the all thrusters group, the value given is from the mesh 
cell with the maximum computed flux, computed as explained above (i.e. the sum 
of the sum of the most energetic ray from each thruster on a given cell).   
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3.3 Spread sheet report files 

These files contain cumulated data on the overall geometry and possibly on groups. They are 
intended to give access to the user to synthetic data. One set of data is available for each thruster 
and for the All Thruster: 

• Forces and torques file, extension .ft.xls, always generated 

• Thermal Flux file, extension .tf.xls, always generated 

• Mass Flux file, extension .mf.xls, generated on demand 

Created folder structure 

The files are placed in a subfolder of the computation folder. The name of this subfolder 
is the thruster name. 

In addition, a file containing links to all specific per thruster file is created directly inside 
the computation folder. 

 

 

Result folder structure 

Header 

Links to per thruster file  
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File organisation 

 

 

Header 

Overall 

summed 

results 

Per group 

results 
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